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INTRODUCTION

Thank you for selecting RDA RESERVE MANAGEMENT SOFTWARE .

Reserve Data Analysis, Inc. is the largest and most reputable reserve analysis company in the
United States.  Since 1983, we have prepared thousands of the most comprehensive, detailed
and useful reserve studies available for more than 4,000 clients throughout the world.  Over the
years, we have developed and fine-tuned the RDA RESERVE MANAGEMENT SOFTWARE  program
to meet the diverse needs of our clients.  And now, the software is available to the general
public!

The RDA RESERVE MANAGEMENT SOFTWARE program is NOT A SPREADSHEET, but rather a
fully-integrated management, computational and projection tool.  Unlike spreadsheet programs,
RDA software allows for greater detail of all major components and more accurate future pro-
jections, without limiting itself to a twenty or thirty-year window.

The program allows for computation of compounded interest and periodic percentage increases
in reserve contributions consistent with or independent of inflationary trends.  The software
gives the user the ability to calculate data using any or all of the calculation methods currently
being used in the reserve analysis industry.  RDA software incorporates the sophisticated pro-
prietary RDA Method, the popular Cash Flow Method, the Component Method and others.
This allows the client to become fully-funded while keeping the required monthly contributions
as low as possible, and either decreases or eliminates the need for special assessments.

RDA software is completely menu-driven.  The current RDA program can be run within a win-
dow by users that have Microsoft  Windows  version 3.0 (or higher) and a computer with a
386 (or higher) processor.
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SOFTWARE INSTALLATION

The RDA program has the following system requirements:

• IBM PC or 100% compatible
• EGA, VGA or higher color graphics
• 101-key extended keyboard or compatible
• 640K RAM
• MS-DOS version 2.1 or higher
• Hard disk with 3 MB of available space

Place distribution disk #1 in the computer’s disk drive (A: or B:) and make that drive the current
directory.  At the DOS A:> or B:> prompt, type “INSTALL” and press <ENTER>.

INSTALL is an executable program file that will prompt the user for information to install the
RDA program to the hard disk drive in the directory chosen by the user.

The installation process should only take a few moments to create the appropriate directory
and copy the necessary files.

GETTING STARTED

Once the RDA program is loaded on the computer’s hard drive, the user may run the program
by typing “RESERVE”  or "R" and <ENTER> at the directory containing the program files or by
setting up "shortcut icons" from within Windows.  A batch file named R.BAT is created by the
installation program and placed in the root directory of the disk drive in which the program has
been loaded.  This file will automatically change to the directory containing the reserve program
files and load the reserve program by simply pressing "R" from any directory in the drive.  In
order for this to work, you will need to modify the computer’s AUTOEXEC.BAT file to include
the root directory location in the PATH statement.  See your DOS user's manual that came with
your computer or call us for assistance.

The first time the program is run, the user will be prompted to establish certain default settings.
This process is automatically suggested by the installation program at the time you load the
program.  The user should accept the suggested settings if uncertain as to their effects.  The
default settings will be saved as an ASCII text file named DEFAULTS.TXT in the directory
where the program files are located.    These are default settings only and the user may change
them at any time while using the program by choosing the Default Settings command on the
Options Menu.  For the fastest setup, just accept all default settings at this time.
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USER FILE TYPES

There are four data files that are edited and used by the RDA program each time a report
version is created, edited and calculated.  The four data files, or family,  for each report version
include the following:

• Master Information File M###1.DTA
• Asset File A###1.DTA
• Summary Calculations File S###1.DTA
• Projections File P###1.DTA

In each of these file names, the “###” corresponds to a 3 digit report version number ranging
from 001 to 999.  When opening, copying, renaming, or otherwise working with these files, the
user need only enter the report version number to address the entire family of files.

The number “1” following the "###"  identifies that the data file structures are in the initial format
created by the designer of the program.  As the program is developed, a change in this number
will allow the program to recognize earlier data file versions for automated conversion as may
be necessary.    The “.DTA” extension references the files as data files.  This may be used to
conveniently copy or move entire groups of files with the DOS *.DTA reference for the entire
group.

The Master Information File and the Asset File will be automatically opened each time a report
version is accessed simply by entering the report number your are working on.  Multiple report
versions can be stored in the same directory at the same time, each with a unique version
number.  The user cannot directly access the Summary Calculations File or the Projections File
as these files are created by the program, however, the user may see the contents of these files
at any time from within the program.

The Master Information File includes the global information for the report version, including the
client’s name, location, financial parameters, etc.  This file is described in detail in the EDITING
THE MASTER INFORMATION FILE section of this User’s Manual.

The Asset File contains all of the records for each of the components in the report version.  This
file is initially 64K bytes in size and increases by 32K byte increments as additional asset
records are appended into this file.  This file is described in detail in the EDITING THE ASSET
FILE section of this User’s Manual.

Once the Master Information File and Asset File are complete, the necessary calculations can
be performed to determine the results of the analysis using several calculation methods.  The
process of calculating the data, which is described in detail in the CALCULATION METHODS
and REPORT MENU sections of the User’s Manual, creates the Summary Calculations File
and the Projections File.   These files are also accessed when viewing or printing reports.
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WORKING WITH MENUS

Menus may be accessed at any time by pressing and holding down either the <CONTROL> or
the <ALT> key and pressing the corresponding highlighted letter.  Some or all of the com-
mands on a given menu may not be available at all times.  For example, the Edit Menu com-
mands are only available while the Asset File of a report version is open.  The seven menus
are:

H or F + f File Menu

H or F + e Edit Menu

H or F + v View Menu

H or F + s Search Menu

H or F + r Report Menu

H or F + o Options Menu

H or F + l Help Menu

FILE MENU H or F + f

p Path

The Path command indicates the disk drive and directory where the report version data
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files will be accessed and stored.  When the program saves data for a particular report
version, the data files and calculations are saved on the disk drive and in the directory
specified by this option.

If the data files for each client (or location) are saved on a floppy disk drive, the Path
should be set to “A:” or “B:”.  If the data files are saved on a hard disk drive, the Path
should be set to the appropriate path and directory.  The path and directory where data
files will be stored on a hard disk drive may be any directory or subdirectory which exists
on the hard disk drive.  For example, all of the data files for the XYZ Entity may be saved
in its own subdirectory by selecting the path “C:\XYZ”.  Note that the subdirectory must
already exist on the hard disk drive.  The user may create a subdirectory at any time by
“shelling-out” to DOS as described in the DOS Shell command (below) and using the
DOS “MD” (Make Directory) command.  (See the DOS manual for more information on
making directories.)

The default path when you first run the program is set to the directory containing the
program files and the version number is set to "001."  As you change these settings they
are remembered and suggested as the default when you continue to work with the
program or start the program again.

d Directory

The Directory command displays a list of files on the drive or directory specified by the
Path statement.  The default Directory extension setting is “*.DTA”, which will display
only the data files for each report version.

The Directory extension is one of the Default Settings that may be viewed and edited
from the Options Menu.

o Open File . . .

The Open File command allows the user to create or load a particular report version.
Report versions are named according to their three-digit version number, ranging from
001 to 999.  When the user enters a three-digit number and presses <ENTER>, the
Master Information for that report version will be loaded and displayed on the screen if
the report version specified already exists.  If the report version specified does not exist,
the appropriate files will be created and a blank Master Information screen will be dis-
played.  The user may enter "1", "01" or "001" to access or create version 1 of your
report.  Internally, the program will convert the entry to the three digit format "001".

f Close File

The Close File command saves any changes that have been made to the information
displayed on the screen and closes the current file.  If the user is viewing the Master
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Information File, this command will automatically close that file and the Asset File.  If the
user is viewing the Asset File, this command will also close the Master File.

c Copy Files . . .

The Copy Files command allows the user to copy a report version from one drive or
directory to another.  This command may also be used to make a duplicate copy of a
report version and rename it with a different report version number.

The latter is useful when the user wants a duplicate copy of a completed report version
to experiment with by changing some of the assumptions to run “What if’s...”  By making
a duplicate copy of a report version, the user can make changes without fear of forget-
ting which information and parameters from the original have been changed.  It is gener-
ally a good idea to keep earlier versions of the report intact in case the user ever needs
to return to one of them for information that may later have been changed or deleted.

r Rename File . . .

The Rename File command allows the user to change the report version number with-
out making a duplicate copy.

t Delete Files . . .

The Delete Files command allows the user to completely erase all of the data files asso-
ciated with a particular report version.  Note that if a report version is deleted and then
reopened with the Open File command, a blank Master Information screen will be dis-
played.  The original data will no longer be accessible.

If a particular report version is accidentally erased, it may be recovered.  Immediately
exit the program (do not reopen the version) and use the unerase feature of a DOS utility
program.  An unerase utility is included in MS-DOS  version 6.0 (or higher) or in Norton
Utilities .

m Compress File . . .

The Compress File command allows the user to decrease the size of a particular report
version’s Asset File.  This command should be used when a large number of assets has
been deleted from a particular report version.  Using this command on a large Asset File
(more than 100 assets) will increase the overall speed and efficiency of that file.

When records are deleted from a database, the size of your disk file does not change.
Instead, the deleted data is marked, and the program begins to reuse the space in the
file as you add to the database.  This utility performs two functions.  First, if there is a
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total of 32K of data marked for deletion, the program actually reduces the size of the disk
file in increments of 32K.  If there is less than 32K of data marked for deletion, there is no
effect on the size of the file.  However, any time you run this utility, records marked for
deletion are removed and the database is copied, record by record, into a database
having the same name.  The effect of compaction is improved performance, in the same
way that compacting a hard disk improves performance.

This utility renames your original database with the .BAK extension.  You will need room
on the disk drive for both the new compacted file and the old file.  At the end of compac-
tion you will be given the opportunity to erase the .BAK file.  You may first want to be
sure the new data file is working properly before you take this action.

e Repair File . . .

The Repair File command allows the user to repair and reconstruct data files that have
been damaged.  Due to a variety of mechanical and other unforeseen errors, data files
may become corrupt and the user may have difficulty in accessing records.

Should an error occur, the Repair File command allows the user to reconstruct and
repair as much of the damaged file as possible.  You would normally run this utility after
receiving the "File Requires Repair, #88" error message.  If you received another error
message  such as "Disk-Media Error, #72" you should run a disk diagnostic utility such
as Norton Disk Doctor, or try copying the file to another disk or drive before running this
program.  Failing to do so may cause unnecessary loss of data.

When this program restores the database, it systematically goes through every table
and index and recreates the database, using every piece of internally consistent infor-
mation in the file.  If anything is found that cannot be reconciled with other information in
the file, it is deleted.  This restores consistency to the database.  It is possible that some
blocks of data will never be reconciled with the rest of the database, and therefore be
lost.

This utility requires additional space within the database to accomplish its work and will
add at least 32K to the size of the file.  Do not run this program if you do not have the
additional space in the working directory.  You may run the "Compress File" utility after-
wards to remove the additional  space.

The most common cause of damaged databases is failing to close the file before exiting
the program.  This can happen by removing a diskette while in a working file, by a power
failure, or simple turning the computer off before closing the file.  In these cases, data
recovery is usually good.  The program will always attempt to save and close all files
should any unanticipated errors occur.  Exiting the program by means of the File Menu's
Close and Exit commands assures that all files are properly closed.
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u Upgrade Disk/File

The Upgrade Disk/File command is currently used internally by RDA only to convert
data files from earlier C/PM versions of our program to the DOS format.  In the future,
users may use this command to upgrade data files as new DOS versions are released.

i Import/Export/Merge

The Import/Export/Merge command will display the Import/Export/Merge sub-menu.  The
options on this sub-menu allow the user to import data files created by another program
into the RDA program, export RDA data files for use in another program and merge two
or more RDA Asset Files.  The following is a brief description of the options on the
Import/Export/Merge sub-menu:

• Import - This will convert an ASCII text file into an RDA Asset File.  This feature
may save the user a lot of time if a computerized inventory already exists for a new
project.  The user would have to restructure the data being imported to the same struc-
ture used by the RDA program in order for this command to function properly.  The
structure of each asset record in the RDA Asset File is as follows:

Data Field Character Format Max Space
1. Description Alpha/Numeric 35 spaces
2. Asset Number Alpha/Numeric 10 spaces
3. Group/Facility Number Integer ###
4. Category Number Integer ###
5. Placed-in-Service Month Integer ##
6. Placed-In-Service Year Integer ##
7. Useful Life Integer ##
8. Useful Life Adjustment Integer +/- ##
9. Quantity Integer ##,###,###
10. Unit Alpha/Numeric 11 spaces
11. Unit Cost Numeric #,###,###.###
12. Replacement Percentage Numeric ###.##
13. Fixed Accumulated Reserves Numeric #,###,###.##
14. Fixed Monthly Contribution Numeric #,###,###.##
15. Salvage Value Numeric #,###,###.##
16. One-Time Replacement Alpha 1 space
17. Standard Comment Line 1 Alpha/Numeric 3 spaces
18. Standard Comment Line 2 Alpha/Numeric 3 spaces
19. Standard Comment Line 3 Alpha/Numeric 3 spaces
20. Remark Line 1 Alpha/Numeric 75 spaces
21. Remark Line 2 Alpha/Numeric 75 spaces
22. Remark Line 3 Alpha/Numeric 75 spaces



RDA RESERVE MANAGEMENT SOFTWARE

PAGE 15

Data Field Character Format Max Space
23. Remark Line 4 Alpha/Numeric 75 spaces
24. Remark Line 5 Alpha/Numeric 75 spaces
25. Remark Line 6 Alpha/Numeric 75 spaces
26. Remark Line 7 Alpha/Numeric 75 spaces
27. Remark Line 8 Alpha/Numeric 75 spaces
28. Remark Line 9 Alpha/Numeric 75 spaces
29. Remark Line 10 Alpha/Numeric 75 spaces
30. Remaining Life Integer ##
31. Current Cost Numeric ##,###,###,###.##
32. Ideal Accumulated Reserves Numeric ##,###,###,###.##
33. Assigned Accumulated Reserves Numeric ##,###,###,###.##
34. Monthly Membership Contribution Numeric #,###,###.##
35. Monthly Interest Contribution Numeric #,###,###.##
36. Detail Printing Page Number Integer ###

• Export - This will convert an RDA Asset File into an ASCII text file.  Each data
field in this ASCII text file is surrounded by quotation marks and separated by commas.
This feature may be used to compile the data into a different format for use in other
programs for many other purposes.

• Merge - This will combine two existing RDA Asset Files.  This command auto-
matically adjusts the asset numbers of the asset records in the Asset File being merged
so that they do not correspond to the asset numbers of the asset records to which the
Asset File is being merged.  This feature is useful for larger clients that want separate
reports for different facilities, but also want an overall report.

s DOS Shell

The DOS Shell command temporarily suspends the RDA program in memory and takes
the user directly to the computer’s system prompt.  At this prompt the user can complete
any of the DOS functions or run other programs as the computer system’s memory
configuration permits.  Typing “EXIT” and pressing <ENTER>, will exit the Shell pro-
gram and return to the suspended RDA program.  Be sure to exit the Shell program and
do not restart the RDA program by typing “RESERVE” or “R”.

x Exit

This option saves changes, closes all files and exits the RDA program.
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EDIT MENU H or F + eeeee

The Edit Menu is only available while the user is viewing the Asset File of a report version.  The
program’s Mode is displayed at the bottom right-hand side of the screen at all times.

v View Only Mode

The View Only Mode command disables any keys which would allow the user to make
changes to the information displayed on the screen.  This option should be enabled if
the user wishes to view the data and ensure that the data will not be accidentally altered.
This option enables the user to scroll more quickly through the entire report version with
the <PAGE UP> and <PAGE DOWN> keys reading the disk only and not writing any
information.

e Edit Records

The Edit Records command enables the keys which allow the user to alter the informa-
tion displayed on the screen.  With this command enabled, any changes to the fields in
a particular asset record will automatically be saved when the <PAGE UP>, <PAGE
DOWN> or any menu key is pressed.

Note: The program will automatically go into the Edit Mode when the Asset File of an
existing report version is opened.
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a Add Records

The Add Records command allows the user to add new asset records to the Asset File.
This command enables the keys which allow the user to alter the information displayed
on the screen.  With this command enabled, the fields in a particular asset will automati-
cally be saved when the <PAGE UP>, <PAGE DOWN> or any menu key is pressed.

Note: The program will automatically go into the Add Mode when the Asset File of a new
report version is opened.

d Delete Record

The Delete Record command allows the user to permanently delete the record currently
displayed on the screen.  Once an asset record is deleted it may not be recovered.  The
user must be in the Edit Mode to delete an asset record.

VIEW MENU H or F + v

The View Menu is only available while the user is viewing the Asset File of a report version.

! Master Database

The Master Database command displays a window containing an alphabetical list of the
common reserve components included in the Master Database of local costs and useful
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lives.  See THE MASTER DATABASE section in the User’s Manual for a detailed expla-
nation of the use and features available with this command.

@ Standard Remarks

The Standard Remarks command displays a window containing the Standard Remarks
database used by RDA in preparing reserve studies.  See THE STANDARD REMARKS
DATABASE section in the User’s Manual for a detailed explanation of the use and
features available with this command.

$ Asset File

The Asset File command displays a window containing all of the assets in your working
file.  The user can use the up or down arrow keys to scroll through the file and select any
asset for editing.  Typing any key words will allow the user to scan to a particular asset
by description.

b RDA Database

This option allows the user to select and use the database of costs and useful lives that
is supplied by Reserve Data Analysis.  When this option is selected, pressing the <F1>
function key will access this file.

u Custom Database

Selecting this option will access a custom database of costs and useful lives as may be
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developed by the user.  By adding your own records to this file, rather than the RDA
Database,  the user can upgrade to future versions of the RDA Database without losing
data that may have been acquired by the individual user.  When installing updated ver-
sions of the RDA Database, the file is simply copied over the existing "DATABASE.MDB"
file.  The file name of the Custom Database is "CUSTOM.MDB."

Change Index:

The Change Index feature is a group of commands that allows the user to select the order in
which the asset records are presented as <PAGE UP> and <PAGE DOWN> are pressed.  The
five indexes by which the asset records may be viewed are:

c Category View by Category (program default)

g Group/Facility View by Group or Facility

a Asset Number View by Asset Number

r Remaining Life View in Remaining Life Order

d Data File Order View in order records were saved to the disk

Within the index by which the asset records are sorted, the asset records are presented in
alphabetical order based on their description.

Note: If the indexing field within an asset record is changed, the asset record will automatically
assume the resorted position within that index.
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SEARCH MENU H or F + s

The Search Menu is only available while the user is viewing the Asset File of a report version.

g Goto Record . . .

The Goto Record command allows the user to advance to a particular asset number.
This command will prompt the user to enter an asset number for which to search.  If the
asset number requested does not exist, the program will advance to the last asset record
in the report version and notify the user that the asset number entered by the user was
not found.

f Find String . . .

The Find String command allows the user to advance to a particular asset record whose
description contains the characters specified.  This command will prompt the user to
enter a “string” to be sought.  If the string requested does not exist, the program will
advance to the last asset record in the report version and notify the user that the string
requested by the user was not found.  The Find String command is not case sensitive.

Example: To find the asset record containing information about the pool filter, simply
select the Find String command and enter the word “filter.”  The program will search the
entire report version from the beginning for the first occurrence of the characters speci-
fied by the user.

The Find String command can also be used to find asset records which are not com-
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plete.  When making a “first pass” through a report version, the user may identify asset
records which will require additional information or research with a unique symbol such
as @, $ or *.  Later, the user can go back and search for each symbol and do the
required research to complete the information required for each asset record.

REPORT MENU H or F + r

The Report Menu may be accessed at any time while editing or when there is no open report
version.  If the user is not working on a report version when the Report Menu is accessed, the
program will prompt the user for the report version to be processed.  While editing a report
version, the commands in the Report Menu will be run on the report version that is currently
open.  When any Report Menu command is completed, the program will return to the place
where the user accessed the Report Menu.

For a detailed explanation of the different calculation methods available on the Reports Menu,
see the CALCULATION METHODS section in this User’s Manual.

Calculate & View:
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r RDA Summary

The RDA Summary command may be used to calculate the current fiscal year results
using the RDA Calculation Method.  The program will perform the required calculations
and display the required monthly contribution to reserves, the average net monthly inter-
est contribution for the current year, the net monthly allocation to reserves, the total
current replacement cost of all components, the ideal accumulated reserves, the actual
distributed accumulated reserves and any excess accumulated reserves.

t RDA Projections
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The RDA Projections command may be used to calculate future projections using the
RDA Calculation Method.

This command will prompt the user to enter the number of years the program should
calculate future projections for.  The program will perform the required calculations and
display the projections for each year of the current replacement cost, member contribu-
tion, interest contribution, annual expenditures, projected ending reserve balance, ideal
ending reserve balance and the percentage of ideal funding.

Note: The future projections are saved as ASCII text in a data file called “P###1.DTA”
where the “###” corresponds to the report version number.  This file may be opened,
edited and graphed with most spreadsheet programs.

c Cash Flow Minimum

The Cash Flow Minimum command will calculate the minimum monthly reserve contri-
bution required to pay for all reserve expenditures as they occur and ensure that the
reserve fund balance never drops below the dollar amount specified by the user.

This command will prompt the user to enter the minimum dollar amount to maintain.  The
default amount is $0, but the user may wish to allow for a contingency or “cushion.”  The
program will perform the required calculations and display the projections for each year
of the current replacement cost, member contribution, interest contribution, annual ex-
penditures, projected ending reserve balance, ideal ending reserve balance and the
percentage of ideal funding.

This command takes into consideration only those asset records that show an expendi-
ture at some point in time.  If an asset record has Fixed Accumulated Reserves and/or a
Fixed Monthly Contribution, but no Current Cost, it will not be included in this Cash Flow
Calculation.

This command uses data created by the Calculate & View - RDA Projections com-
mand on the Reports Menu.  The number of years under consideration and the annual
expenditure data from the RDA Projections are utilized by this command.  When any
data has been changed which would affect these calculations, the RDA Projections
should be completed prior to running this option.

f Cash Flow Specific

The Cash Flow Specific command will calculate the future projections based on the
monthly contribution entered by the user.

This command will prompt the user to enter the monthly contribution to be tested.  The
program will perform the required calculations and display the projections for each year
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of the current replacement cost, member contribution, interest contribution, annual ex-
penditures, projected ending reserve balance, ideal ending reserve balance and the
percentage of ideal funding.  The data will be calculated based on the user’s input and
may not provide enough money for all of the reserve expenditures as they occur and
consequently, the reserve fund balance may drop well below $0.

This command takes into consideration only those asset records that show an expendi-
ture at some point in time.  If an asset record has Fixed Accumulated Reserves and/or a
Fixed Monthly Contribution, but no Current Cost, it will not be included in this Cash Flow
Calculation.

This command uses data created by the Calculate & View - RDA Projections com-
mand on the Reports Menu.  The number of years under consideration and the annual
expenditure data from the RDA Projections are utilized by this command.  When any
data has been changed which would affect these calculations, the RDA Projections
should be completed prior to running this option.

View Only:

The following commands are View Only.  These commands will display the results of the most
recent calculations made with the “Calculate & View” commands without recalculating the data.
When any data has been changed which would affect these calculations, the proper “Calculate
& View” command should be completed prior to running these View Only commands.

u RDA Summary

The RDA Summary command will display the RDA Summary most recently calculated
from the Calculate & View command with the same name.

j RDA Projections

The RDA Projections command will display the RDA projections most recently calcu-
lated from the Calculate & View command with the same name.

m Cash Flow Minimum

The Cash Flow Minimum command will display the Cash Flow Minimum projections
most recently calculated from the Calculate & View command with the same name.
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s Cash Flow Specific

The Cash Flow Specific command will display the Cash Flow Specific projections most
recently calculated from the Calculate & View command with the same name.

d RDA Distribution

The RDA Distribution command will display the Distribution of Accumulated Reserves
summary.  Each asset record will be displayed in remaining life order with its corre-
sponding ideal accumulated reserves and actual accumulated reserves at the beginning
of the fiscal year for which the report version is being prepared.  The overall percentage
of ideal funding at the beginning of the fiscal year is also displayed at the bottom of this
summary.

This command uses data created by the Calculate & View - RDA Summary com-
mand on the Reports Menu.  When any data has been changed which would affect
these calculations, the RDA Summary should be completed prior to running this option.
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l RDA Asset Listing

The RDA Asset Listing command will display the Asset Listing / Summary in category
order.  Each asset record will be displayed by category with its remaining life, current
cost, monthly contribution and net monthly allocation for the fiscal year for which the
report version is being prepared.  The overall totals for the fiscal year are also displayed
at the bottom of this summary.

This command uses data created by the Calculate & View - RDA Summary com-
mand on the Reports Menu.  When any data has been changed which would affect
these calculations, the RDA Summary should be completed prior to running this option.

g Charts & Graphs

Users who have Microsoft  Windows  3.0 (or greater) and Microsoft  Excel  3.0 (or
greater) will be able to print charts and graphs which are created with an Excel  macro
developed by RDA.
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p Print Reports . . .

The Print Reports command will automatically calculate the RDA Summary and the
RDA Future Projections if they have not already been calculated.  If the calculations
exist, the program will indicate that calculations exist and prompt the user to recalculate.
When any data has been changed which would affect the calculations, the user should
recalculate the data prior to printing.  If no data has been changed which would affect
the calculations, the user may bypass the calculation process.

After the calculations are completed or bypassed, this command brings up the Report
Printing sub-menu.  This menu includes a standard report option, summary report option
or the ability to choose the contents of a custom report from over 30 choices.

Once in the Report Printing sub-menu, use the <UP ARROW> and <DOWN ARROW>
keys to move from option to option.  Use the <SPACEBAR> to select or deselect the
options desired.  Choosing one of the Report Processing Options from the first few
choices will automatically select a number of items to be printed for a pre-formatted
report.  An item is selected to be printed when a “√” is present to the left of the item.

When all components desired are selected, press <ENTER> to start printing.  While the
program is printing, a blinking “≡” will appear next to the “√” while the program is printing
that particular item and the status bar at the bottom left-hand side of the screen will
indicate the percentage of completion for printing that particular item.  A “♦ ” will replace
the blinking “≡” when that item has been completely printed.  Press <ESCAPE> to quit or
terminate printing at any time.

The following is a brief description of the options on the Report Printing sub-menu:
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• Billing Request - This will print a page that includes the client name, account
number, version number and other data that will be useful for the user to generate in-
voices from.

• Report Cover - This will print a page that includes the client name, account num-
ber, version number and copyright information.

• Section 1 - This will print several pages of introduction which are designed to be
the first section read by a reserve study client.  Topics include determining reserve
expenses vs. operating expenses, preparing the reserve study, methods used in calcu-
lating the reserve study, a reserve study user’s guide and definitions of terms used
within the report.

The user may substitute the Section 1 provided with any sort of information desired
to produce a completely customized report.  To print Section 1, the program simply
copies a spooled print file to the printer.  When the default printer is set for a “LaserJet
II” or “LaserJet III,” the program copies a print file named “SEC1_LSR.PRN” to the
printer.  When the default printer is set for an “Other Printer,” the program copies a
print file named “SEC1_OTH.PRN” to the printer.  To substitute Section 1 with a
customized Section 1, the following is required:

• Rename the existing print files to “SEC1_LSR.OLD” AND “SEC1_OTH.OLD”

• Create the document to use as the new Section 1.

• Print that document to a file named “SEC1_LSR.PRN” if printing with a LaserJet
or to a file named “SEC1_OTH.PRN” if another type of printer is being used. (See the
word processing manuals for more information on “printing to a file.”)

• Copy the new print file to the directory where the program files are located.

• Summary Page - This will print a page that displays data from the Master Infor-
mation File and the RDA Summary information.

• Timeshare Summary - This will print a page that displays data from the Master
Information File and the RDA Summary information in a format suitable for timeshare
clients.

• Distribution - This will print the Distribution of Accumulated Reserves summary
for the fiscal year for which the report version is prepared.

• Category Listing - This will print the Asset Listing / Summary in category order for
the fiscal year for which the report version is prepared.

• Group Listing - This will print the Asset Listing / Summary in group/facility order
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for the fiscal year for which the report version is prepared.

• Category Detail - This will print the detail of each asset record in category order.

• RDA Projections - This will print the future projections most recently calculated by
the RDA Method.

• Detail Index - This will print a listing of each asset record in alphabetical order and
will include each asset record’s asset number and detail report page number.

• Section 3 - This will print a “notes” section designed to be placed at the end of the
printed report.

The user may substitute the Section 3 provided with any sort of information desired
to produce a completely customized report.  To print Section 3, the program simply
copies a print file to the printer.  When the default printer is set for a “LaserJet II” or
“LaserJet III,” the program copies a print file named “SEC3_LSR.PRN” to the printer.
When the default printer is set for an “Other Printer,” the program copies a print file
named “SEC3_OTH.PRN” to the printer.  To substitute Section 3 with a customized
Section 3, the user should follow the steps outlined in the description of Section 1
(above).

• Table of Contents - This will print a table of contents.

• California Summary - This will print a summary report that was designed to meet
the disclosure requirements of the State of California.  This report contains the RDA
Report Summary as well as information for each asset record in the report version.
(This report is normally not bound into the final reserve study so that it can be easily
copied and mailed to the client’s membership.)

• Fax Summary - This will print the Membership Report as described above.  It is
called the Fax Summary because it has no shaded boxes or bold print which allows for
a faster facsimile transmission.

• Group Summary - This will print the Asset Listing/Summary in group/facility order
for the fiscal year for which the report version is prepared.

• Bid Spec Sheets - This will print a separate page to be used as specification
sheets for each asset record that is scheduled to be repaired or replaced during the
fiscal year for which the report version is prepared.  Each page will have the asset
record’s description, placed in service date, useful life and inventory.  There is ample
space provided for the client to add remarks such as deadlines or material specifica-
tions.

• CF Projections - This will print the future projections most recently calculated by
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the Cash Flow Method.

• CFS Projections - This will print the future projections most recently calculated by
the Cash Flow Specific Method.

OPTIONS MENU H or F + o

d Default Settings

The Default Settings command allows the user to view and edit the default settings.
Some of the settings that may be edited are as follows:

• Drive and directory path of the program files

• Extension to be used in the File Menu’s Directory command.  For more informa-
tion, see the Directory Command on the File Menu.

• Time before program’s screen-saver utility is activated.  The user may select any
number of minutes from 0 to 99.  Choosing 0 will disable the screen-saver utility.

• Type of printer

• Name of the state where most of the user’s clients are located

• User’s name and three lines for an address or other information
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• Global financial parameters (i.e., inflation, interest, etc.)

• Master Information File remarks section
i Index Database

This option will allow the user to change all of the cost data in the master database file by
the selected multiplier.  This is useful for users who need to index the cost data to
locations other than their local geographic area.  Reserve Data Analysis maintains cost
indexes on most every major city in North America.  This information is provided, free of
charge, for our users.

HELP MENU H or F + l

All of the Help Menu items may be viewed by pressing <PAGE UP> or <PAGE DOWN> to
scroll through the information.  Pressing <ESCAPE> will return the user to the program.
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q Quick Reference

The Quick Reference command will display the editing and function keys.  This display
is similar to the Quick Reference Sheet included as an addendum in this User’s Manual.
This menu can also be accessed by pressing the <F7> function key.

u User’s Manual

The User’s Manual command will display the text of the User’s Manual.

The User’s Manual is included with the program files as an ASCII text file called
MANUAL.TXT that may be viewed, edited or printed with most word processing pro-
grams.

t Trouble Shooting

This option accesses a file containing information on some common problems and  their
solutions.

e Error Codes

The Error Codes command will display a list of error codes that may occur while working
with the program.  The first few screens will show the error number and a brief descrip-
tion of the error.  The remaining screens will show a detailed explanation of each error
code along with possible solutions.
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s Software Demo

This will run our software demonstration program.  It will display the many features the
program offers as well as an explanation describing how to use the program.

a Additional Support

This option will describe additional services provided by Reserve Data Analysis.

BASICS OF EDITING

Upon moving to any individual data field, the cursor is positioned at the end of the field.  Nu-
meric-only fields will accept only numeric input.  Alphanumeric fields will accept any character
available on the user’s keyboard.  The following editing keys may be used:

• <PAGE DOWN> and <PAGE UP> - saves changes to the current asset record
and moves forward or backward to the next asset record.

• <UP ARROW> and <DOWN ARROW> - moves the cursor from one data field to
another, either up or down.

• <ENTER> - moves the cursor to the next data field down.

• <LEFT ARROW> and <RIGHT ARROW> - moves the cursor position within the
current data field.

• <HOME> - moves the cursor to the first position within the current data field.

• <END> - moves the cursor to the last position within the current data field.

• <DELETE> - deletes the character at the cursor’s position within the current data
field.

• <BACKSPACE> - removes the character to the left of the cursor’s position within
the current data field.

• <CONTROL> <BACKSPACE> - deletes the entire contents of the current data
field and places the cursor at the first position within the data field.

• <ESCAPE> then <HIGHLIGHTED LETTER> - moves the cursor to the data field
of the highlighted key chosen.  <ESCAPE> & <ESCAPE> will move the cursor to the
description data field.
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EDITING THE MASTER INFORMATION FILE

The following data fields are located in the Master Information File:

• Account Number - This is a four to five digit number.  Users of the Professional
Version will find it useful to assign an account number to each of their clients for billing
and account tracking.  User’s of the Basic Version, should enter their RDA account
number in this field.

• Account Name - The client’s legal name.

• City/State - The city and state where the project is located.

• Units - The total number of units which are included in the report version.  If the
project is in phase development, indicate only the number of units which will be in place
at the beginning of the fiscal year for which the report version is being prepared.

• Phasing - Two numeric entries are required.  The first entry is the number of
construction phases included within the current report version and the second reflects
the total number of phases at build out.

• Prepared By - Four data fields are provided.  The user may wish to enter their
name, company name, address and/or telephone number.  The report cover will have
“Prepared By:” and these four data fields centered near the bottom of the page.

• Inflation - This figure is used to approximate the future cost to repair or replace
each asset record in the report version.  The current cost for each asset record is com-
pounded on an annual basis by the number of remaining years to replacement.
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• Increase - This is the percentage rate at which the client will increase its reserve
contribution to each component at the end of each year until the year of replacement.
The idea is to start by setting aside a lower amount and increase that amount each year
in accordance with the planned percentage.  Ideally, this figure should match the rate of
inflation.  It can however, be used to aid those clients who have not set aside appropri-
ate reserves in the past by making the initial year’s allocations less formidable.

For example, in order to accumulate $10,000 in 10 years, the client could set
aside $1,000 per year.  As an alternative, the client could set aside $795 the first year
and increase that amount by 5% each year until the year of replacement.  In either case,
the client would accumulate $10,000 in 10 years.

• Investment Yield - The average interest rate anticipated by the client based upon
their current investment practices.

• Taxes on Yield - The estimated percentage of interest income which will be set
aside for taxes.

• Contingency - Enter the total percentage of reserves which will be set aside to
accumulate as a contingency.  For most condominium associations, this figure can be
within the range of three to five percent.  In complex situations or in the case of high-rise
buildings, the client may wish to have a contingency as high as a 10 percent.

• Reserves - Enter the total reserve balance as of the beginning of the fiscal year
for which the report version is being prepared.  To project the future balance, use the
most current total reserve figure available from the balance sheet, add monthly contribu-
tions to reserves and subtract any expenses anticipated between the date of the bal-
ance sheet and the fiscal year beginning for which the report version is being prepared.

• Fiscal Year Beginning Date - Enter the month, day and year which marks the
beginning of the fiscal year for which the report version is being prepared.  This date is
most important as the entire report version revolves around it.  This date is also used
internally by the program to calculate the estimated remaining life of each asset record
based upon its original placed in service date and useful life.  When preparing a report
version several months in advance of this date, it is important to reflect all changes in the
report version which will occur before that date.

For instance, if the fiscal year begins January 1 and the report version is being
prepared several months in advance of January 1, all components which will be
repaired or replaced prior to that date should be indicated in the report version as
having been replaced.

• Fiscal Year Ending Date - Enter the month, day and year marking the end of the
fiscal year for which the report version is being prepared.
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• Project Detail - There are 10 data fields available for whatever the user desires.
These fields may be used to describe when the project was originally constructed, how
the development was phased, when the last field inspection for reserve study purposes
was done or any other descriptive information which might be useful in understanding
how the report version was compiled.

Upon completing the Master Information File, the user can access the Asset File automatically
by simply pressing the <PAGE DOWN> key.  This will open the Asset File and place the user in
the first record of that file if previous records exist.  If the file is empty, a blank form will be
presented for record entry.  If many records exist, the user can scroll through this file using the
<PAGE UP> and <PAGE DOWN> keys.  Pressing <PAGE UP> at the first record in this file will
take the user back to the Master Information File.  The user can save and close the Master
Information File and Asset File automatically by using the File Close or Exit commands on the
File Menu.

EDITING THE ASSET FILE

As indicated above, pressing <PAGE DOWN> after viewing the Master Information File will
immediately access the Asset File.   The program will automatically start in the EDIT MODE at
the first asset record if the report version previously existed.  If the report version is new, the
program automatically starts in the ADD mode.  The user may change modes by using the
commands on the Edit Menu.  Pressing <ESCAPE> and the highlighted letter of a data field will
move the cursor to that data field.  The <PAGE UP> and <PAGE DOWN> keys are used to
scroll through each of the individual asset records.  Pressing <PAGE UP> at the first record in
this file returns you to the Master Information File.  The individual data fields for each asset
record are described as follows:



RDA RESERVE MANAGEMENT SOFTWARE

PAGE 37

• Description - This is an alpha/numeric field consisting of 35 characters.  Any
combination of characters may be used to uniquely identify each asset record.

• Asset ID - This is an alpha/numeric field consisting of 10 characters.  Any combi-
nation of characters may be used to uniquely identify each asset record.  In the ADD
mode the program will suggest the next available numeric entry beginning with 1001.  It
is suggested that the user allow the program to generate these unique identifications for
each asset record.

• Group or Facility  - This numeric field is the secondary sorting parameter.  The
Asset File may be viewed according to this data field by using the View Menu.  The
report can also be printed according to this data field.  This parameter may be used to
identify each asset record’s location, building, phase, etc.  The program’s default sort is
by category which is described below.

• Category - This numeric field is the primary sorting parameter.  The Asset File’s
default viewing index and default Detail Report printing index is based on this data field.
This parameter may be used to identify each asset record’s category (i.e., roofing, paint-
ing, etc.).  The following are the typical categories used by RDA in the preparation of our
reports and in the Master Database:

10 Streets/Asphalt
20 Roofing
30 Painting
40 Fencing/Security
50 Lighting
60 Recreation/Pool/Etc.
70 Interior Furnishings/Clubhouse/Etc.
80 Equipment
90 Miscellaneous Building Components
100 Miscellaneous Grounds Components

• Placed In Service Date - Enter the month and year the asset record was placed in
service.  This is the date from which the asset record is aged.

• Useful Life - Enter the useful life anticipated for the asset record.  If a useful life of
“0” is assigned, the program will automatically assign the full current replacement cost to
this component regardless of its remaining life, which may be greater than “0” if an
adjustment has been used.  This feature is used exclusively by RDA in our Settlement
Solution Services  when a construction defect repair component needs to have it’s full
current replacement cost distributed to it, but when the repair may not be done during
the fiscal year for which the report version is being prepared.

• Adjustment - Once the useful life is determined, the remaining life may be ad-
justed (plus or minus) by this data field for the current cycle of replacement only.  This
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will allow for a current period adjustment without effecting the estimated replacement
cycles for future replacements.

• Remaining Life/Replacement Year - These fields cannot be edited directly by the
user.  They are the result of calculations based upon the report version’s fiscal year
beginning date, the placed in service date of the component, the useful life of the com-
ponent and the adjustments to the useful life of the component (if assigned).

• Quantity/Unit - Enter the total number or measurement and the unit description
for the particular component (i.e. 400 lin. ft., 5,000 sq. yds., 14 buildings, 1 total, etc.).

• Unit Cost - Enter the cost per unit for the component.  As an example, if a square
footage measurement was entered, the unit cost should be the cost per square foot.

• Percentage Replacement - This data field is usually set at 100 percent.  In some
cases, a component may not be replaced in its entirety or the cost may be shared with a
second party.  In other cases the Percentage Replacement may be higher than 100
percent to allow for a waste factor on some components which should be considered
when replacing them.  In all cases the total square footage is indicated in the quantity
field and the Percentage Replacement reflects the percentage which is being addressed.

Examples of a Percentage Replacement that is lower than 100 percent would be
budgeting for a small percentage of the streets to be repaired or replaced over a
period of time, or sharing the expense to replace a common wall with a neighboring
party.  An example of a Percentage Replacement that is higher than 100 percent
would be carpeting, where the measurement indicated represents the actual area to
be replaced, but a 107 percent Percentage Replacement is used to allow for an
additional 7 percent waste factor when installing the carpeting.

• Current Cost - This data field is calculated based upon the quantity, unit cost, and
percentage replacement data fields as entered.  This data field may not be edited di-
rectly by the user.

• Accumulated Reserves - The program will automatically distribute the reserves in
the most efficient manner possible to all components when the report version is calcu-
lated.  However, if used, this data field will override the normal calculation process of
allocating reserves and “fix” the Accumulated Reserves to the component at the amount
entered.  When this data field is used, the word “(Fixed)” will appear to the right of the
data field.

When this data field is used and there is no Current Cost for an asset record, the Fixed
Accumulated Reserves will equal the ideal level of reserves.  An example of where this
is useful is for a contingency line item such as a slope failure reserve.  A client may wish
to have $10,000 accumulated and designated as the appropriate amount for this com-
ponent.
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• Monthly Contribution - The program automatically calculates the Monthly Contri-
bution requirements necessary for each component.  However, if used, this data field
will override the normal calculation process and “fix” the Monthly Contribution to the
component at the amount entered.  When this data field in used, the word “(Fixed)” will
appear to the right of the data field.

• Salvage Value - Enter the Salvage Value of the component at the time of replace-
ment, if applicable.

• One Time Replacement - This data field is normally set at “No.”  If the component
is to be replaced on a One-Time basis, indicate this by pressing “Y” in this data field.
Using this option will allow the funds to accumulate for replacement at only the first
occurrence.  After this replacement, the component will not be considered for future
replacements.  This option is useful when the client will have a major expense which will
occur only once.

• Comments - Enter the three-character code for the standard remarks to be printed
with the current asset record.  The standard remarks database may be viewed by press-
ing <F2>.  Once a standard remark has been entered in a Comments data field, the text
of the standard remark may be viewed by pressing <F3>.

• Remarks - There are 10 lines available.  Any information may be entered here
such as tables, dates and costs of last replacements, service contractor or vendor infor-
mation, serial numbers, etc.  See the BASICS OF EDITING and SHORTCUT KEYS
sections of this User’s Manual for more information about using the powerful editing and
data manipulation features available in the Remarks section.

MASTER DATABASE

The Master Database contains local area costs and useful lives for over 2,000 typical reserve
components.  The information in this section will explain how the user can view the information
for a particular component and transfer some, all or none of the information into a report ver-
sion.  Each component in this database is formatted in a way that minimizes reformatting once
the record is transferred into a report version and makes the data manipulation as easy as
possible.



RDA RESERVE MANAGEMENT SOFTWARE

PAGE 40

The Master Database command on the View Menu (or <F1>) displays a window containing an
alphabetical list of the reserve components included in the Master Database.  The <UP AR-
ROW> or <DOWN ARROW> keys can be used to scan through the list to find a particular
component.  Or the user may type the first few letters of the desired component and press
<ENTER> to quickly advance through the list.

X Pressing <ESCAPE> exits this window and returns the user to the previously
displayed asset record.

E Pressing <ENTER> will display the database information for the highlighted
component.
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Once a component is displayed on the screen, any or all of the information shown may
be transferred to the current asset record.  The user may select to transfer individual
fields, all of the displayed information or none at all.

g Pressing a highlighted key (when in the EDIT MODE) will transfer the informa-
tion displayed for that individual field only when <ENTER> is pressed.  When in
the ADD MODE, all of the information will be transferred.

E Pressing <ENTER> alone will transfer all of the displayed information to the
current asset record when in the ADD mode.  This feature is disabled when in
the EDIT mode to prevent overwriting errors.

Pressing <F1> again returns to the window that contains the alphabetical list of
the common reserve components included in the Master Database.

X Pressing <ESCAPE> again exits the Master Database window and returns the
user to the previously displayed record.

Note:  If any fields in the current asset record are accidentally overwritten, it can be recovered
by moving the cursor to the overwritten data field or fields and pressing <CONTROL> + C.

The Master Database is continuously updated by RDA.  Each spring, we will send users of the
software an invitation to upgrade to the most current Master Database for a nominal fee.  If a
user happens to come across a component that does not exist in our database, we would be
happy to research the component, but reserve the right to charge the user for this service at our
normal hourly rates.
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The Master Database may be edited by the user in two ways.  The first way is quick and easy
to edit the Master Database “on the fly.”  Components in the Master Database may be edited
while they are being viewed during report version editing by simply pressing the <INSERT>
key.  The user will have the ability to edit any or all of the data fields.  Selecting the File Close
option under the file menu will save the changes made and return to the Asset File.

The second way the Master Database may be edited is to use the Open File command on the
File Menu.  When the program prompts the user for the file to open, type in “DATABASE” and
<ENTER>.  The program will automatically go into VIEW ONLY MODE and display the Master
Database components in alphabetical order.  The user may use the Edit Menu and Search
Menu to add, edit or delete records in the Master Database.

STANDARD REMARKS DATABASE

The Standard Remarks command on the View Menu (or <F2>) displays a window containing
an alphabetical list of the Standard Remarks Database.  The <UP ARROW> or <DOWN AR-
ROW> keys can be used to scan through the list to find a particular Standard Remark.  Or the
user may type the first one to three letters of the desired Standard Remark to quickly advance
through the list.

Each of the existing Standard Remarks is identified by a two or three-character alpha/numeric
code.  These codes may be inserted into any one of the three Comments data fields in each
asset record.  When the detail section of a report version is printed, the Standard Remark code
will cause the entire text of the Standard Remark to be printed for that asset record.
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The Standard Remarks Database may be edited by using the Open File command on the File
Menu.  When the program prompts the user for the file to open, type in “COMMENTS” and
<ENTER>.  The program will automatically go into VIEW ONLY MODE and display the Stan-
dard Remarks Database components in alphabetical order according to their three-character
alpha/numeric code.  The user may use the Edit Menu and Search Menu to add, edit or delete
records in the Standard Remarks Database.

SHORTCUT KEYS

! Opens Master Database.

@ Opens Standard Remarks Database.

# Displays the contents of a Standard Remark when the cursor is located on one of the
three Comment data fields.

$ Allows the user to quickly scan the Asset File.

% Copies all data fields (except the asset number) from the previous asset  record when in
Add Mode.

^ Allows the user to copy an entire Group of Category of assets.
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& Displays the Quick Reference Guide (These shortcut keys).

* Finds and replaces leftmost asterisk (*) on the current Remark data field and
leaves the cursor at that position for data entry.

( Calculates any tables in the Remarks data fields and carries the total to the Unit Cost
data field.  In the following example, the highlighted characters are required for the
program to accurately calculate a table:

Enter:

150 widgets @ 15
200 dingbats @   25.00

The required information for each line of the table includes the quantity, “@” sign and unit cost.
Pressing <F9> will produce the following table centered in the Remarks data fields:

150 widgets @ $ 15.00 = $ 2,250.00
 200 dingbats @ 25.00 = 5,000.00

                      _________
TOTAL  = $ 7,250.00

) Calculates a table in the Remarks data fields (like the <F9> function does) after prompt-
ing the user for a percentage increase (or decrease) in the unit costs desired, and car-
ries total to the unit cost data field.

_ Adds a column of numbers in the Remarks data fields and carries the total to the Quan-
tity data field and unit of measurement to the Unit data field.  In the following example,
the highlighted characters are required for the program to accurately calculate a table:

Enter:

pool area -  1,200 sq. ft.
perimeter - 5,600
units - 10,250

The required information for each line of the table is a description, "-" and the quantity.  The unit
of measurement needs to be on only the first line of the table.  Pressing <F11> will produce the
following table centered in the Remarks data fields:
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pool area - 1,200 sq. ft.
perimeter - 5,600
units - 10,250

______
TOTAL  = 17,050 sq. ft.

+ This is the undo key for <F9>, <F10> and <F11> mistakes.  This key will replace the
Quantity data field, Unit data field, Unit Cost data field, and the Remarks data fields with
the data that existed prior to the mis-stroke of <F9>, <F10> or <F11>.  This key must be
used immediately after a mistake has been made for a successful recovery.

H or F + a Moves one Remark data field to another.  User will be prompted for
the Remark data field to be copied and the Remark data field to be
replaced.

H or F + c Copies current data field from the previously viewed asset record.

H or F + n Inserts one Remark data field and moves other Remark data fields
down.  If  there is anything in the last Remark data field (line 10), it
will be lost.

H or F + p Calculates new Unit Cost after prompting the user for the percent-
age increase (or decrease) desired.

H or F + y Deletes the current Remark data field and moves other Remark
data fields up.

H or F + <BCK SP> Erases the current Remark data field.
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CALCULATION METHODS

RDA Method

The RDA Method is a proprietary calculation process that was developed by RDA and is
available exclusively as a part of the RDA program.  This calculation method segregates
each component in the analysis, which enables it to provide the monthly member and
interest contributions on a line-item by line-item basis.  This calculation method is similar
to the Cash Flow Method because it defers the “make-up” period for any under-funded
reserves over the longest period possible

The first step in this calculation method is to distribute the accumulated reserve funds
among the reserve components in the most efficient manner possible as of the begin-
ning of the fiscal year for which the report version is being prepared.  The ideal level of
reserves is calculated by evaluating each component’s age proportionate to its esti-
mated useful life and current replacement cost.  The equation is as follows:

IDEAL RESERVES = ( AGE / USEFUL LIFE ) X CURRENT REPLACEMENT COST

This method of calculating the ideal level of reserves does not consider future replace-
ment cost, nor interest earned on the accumulated reserves, as the RDA Method does
when calculating the monthly contribution requirements for future replacements.  How-
ever, it is a reliable indicator of the adequacy of a client’s current reserve balance based
on current conditions and replacement costs.

Any components that were assigned “fixed” accumulated reserves by the user are as-
signed those amounts and the contingency reserve is assigned the appropriate amount.
The remainder of the accumulated reserve balance is then assigned to equal the ideal
level of reserves for each component in ascending order by remaining life until there are
no more funds available.  The client is under-funded if the program is not able to distrib-
ute actual reserves to equal the ideal level for each component.  In cases of extreme
under-funded clients, where there are insufficient funds to distribute the ideal level of
reserves to all of the components with a “0” remaining life (scheduled for replacement in
the fiscal year for which the report version is being prepared), the program will automati-
cally adjust the remaining life of some components to “1” year.

The client is over-funded if the program is able to distribute actual reserves to equal the
ideal level for each component and there are still funds left over.  When this occurs, the
program will automatically distribute the remaining funds to equal (but not exceed) each
component’s current replacement cost in ascending order by remaining life until there
are no more funds available.  If the program is able to distribute actual reserves that
equal the current replacement cost of each component, any funds remaining will be
identified as excess reserves.  These excess reserves can be used to offset the monthly
contribution requirements recommended, or used in any other manner the client may
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desire.

Assigning the reserves in this manner defers the make-up period for any under-funding
over the longest remaining life of all the components under consideration, thereby mini-
mizing the impact of deficiency.  If the reserve fund is under-funded, the monthly contri-
bution requirements calculated by the RDA Method can be expected to be higher than
normal.  In the future, as individual components are replaced, the funding requirements
will return to their normal levels.  In the case of a large deficiency, a special assessment
may be considered.  The user can easily generate revised report versions outlining how
the monthly contributions would be affected by such an adjustment, or by any other
changes which may be under consideration.

The next step in this calculation method is to calculate the monthly membership contri-
bution and average monthly interest contribution for each component.  This calculation
process determines the contributions required to fund the difference between each
component’s accumulated reserves (calculated in the distribution above) and the future
replacement cost in the year the component will be replaced.  This process uses a
formula developed by RDA that takes into consideration the parameters for inflation,
annual contribution increases and net investment yield to calculate the monthly mem-
bership and interest contributions for each component.

The advantages of the RDA Method are that it will bring the client up to the ideal level of
funding over time and then keep them very close to the ideal level through time.  When
the client is close to being ideally funded, the increase in monthly contributions required
from year to year are more predictable and special assessments less likely.  The main
disadvantage of this calculation method is that, in some instances, for severely under-
funded clients, the initial year’s monthly contributions will be higher than normal and
higher than the contributions calculated by some of the other calculation methods.

Cash Flow Minimum Method

The Cash Flow Minimum Method takes into consideration only the expenditures over
time and completely disregards the level of ideal funding.  This calculation method will
determine the minimum monthly reserve contribution required to pay for all reserve ex-
penditures as they occur and ensure that the reserve fund balance never drops below
the dollar amount specified by the user.

The Cash Flow analysis features of the program take into consideration only those asset
records that show an expenditure at some point in time.  If an asset record has fixed
accumulated reserves and/or a fixed monthly contribution, but no current cost, it will not
be included in the Cash Flow calculations.  There is also no provision for a contingency
with this calculation method.

The advantages of the Cash Flow Minimum Calculation Method are that it will usually
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produce the lowest monthly reserve contribution requirements for under-funded clients
and the annual increase in this amount will be exactly as chosen by the user.  The main
disadvantage of this calculation method is that it completely disregards the percentage
of ideal funding.  At any point in time the percentage of ideal funding may drop very close
to 0% as the client’s reserve fund gets dangerously close to the minimum balance se-
lected by the user.

Cash Flow Specific Method

The Cash Flow Specific Method takes into consideration only the expenditures over
time and the monthly contribution specified by the user.  This method will calculate
future projections based on the expenditures over time and the user’s monthly contribu-
tion selection.  This method does not necessarily ensure that the reserve fund balance
will never drop below $0.  As with the Cash Flow Minimum Method, this method com-
pletely disregards the level of ideal funding.  This method allows the user to see what
can be anticipated over time based on any monthly contribution to the reserve fund.

The Cash Flow analysis features of the program take into consideration only those asset
records that show an expenditure at some point in time.  If an asset record has fixed
accumulated reserves and/or a fixed monthly contribution, but no current cost, it will not
be included in the Cash Flow calculations.  There is also no provision for a contingency
with this calculation method.

The advantage of the Cash Flow Specific Calculation Method is that it allows the user to
see what can be anticipated over time based on any reserve contribution tested.  The
main disadvantage of this calculation method is that it completely disregards the per-
centage of ideal funding.  At any point in time the percentage of ideal funding may drop
very close to or below 0% as the client’s reserve fund gets dangerously close to or below
$0.

WHERE TO GO FOR HELP

If youe experience any problems with the program, the following actions are suggested:

• Read the User’s Manual sections that might address the problem or question.

• If the program displays an unanticipated error code number, check what the error is by
using the Error Codes command on the Help Menu.

• Call RDA at (800) 359-5015 or fax RDA at (800) 579-5015.  We are available for soft-
ware support Monday through Friday from 8:30 am to 5:00 pm PST.  We are happy to assist
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users with basic software installation and usage questions, but reserve the right to charge for
extended consultation at our normal hourly rates.




